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EndNote °7inejs a Web-based service
designed to help students and
researchers to:

> for citing in
papers, books, thesis, essays
> Uuse as a

> Search



» Import references from other online
bibliographic databases and organize a
library of references

» Store up to per EndNote
online account

»Simplify collaboration with colleagues:
share EndNote on/ine groups and view
groups shared by others

» Use to format in-text
citations and bibliographies



» Edit references—add notes, keywords and
more

>
(requires plug-in) to insert references and
format papers instantly

»Format papers in other word processors using
RTF (rich text format) files

» Attach the pdf file of papers to references Iin
EndNote online



»Use EndNote online toolbars in Microsoft
Internet Explorer and Mozilla® to access your
reference library in one click, and capture
citation data easily (requires plug-in)

» Easily transfer references to and from
EndNote desktop (EndNote X.0.2 and up).
Export/import to previous versions.

» Create lists of "favorites" for online connection
files, import filters and publishing styles



EndNote online VS Endnote Desktop

EndMote basicusers 50,000
EndNote basic & Web of Science users 50,000
EndNote desktop users Inlimited
EndMote desktop & Web of Science users Unlimited

Wy Befarances

Thisuser has a free, limited online version of EndMote.

A basic user has 21 styles and 2GE of storage.

This user has Web of Science.

In addition to the basicfeatures, this user has extra styles and will
see Times Cited counts and other Web of Science data and links in
their library.

Unlimited
Unlimited

Limited Feature Set 21 -
Lirmited Feature Set 3300+
Full Feature Set 3300+ -
Full Feature Set 3300+

This user has EndMote installed on their desktop.
In addition to the basic features, this user has unlimited file storage
and all theimport, export, and style options.

This user has Web of Science and EndMote deskiop.

In addition to unlimited file storage and additional capahilities, this
user will see Times Cited counts and other Web of Science data and
linksin their online library.




Installing EndNote Plug-INS

To access more EndMote features, you can install two types of plug-ins: onefor zapturing
references from your browser window and one that links yoar online librzry to Microsoft™ Wo-d.

Goto the Options tab and select Download
Installers. Herz, you will seeall avzilable
plug-ins.

P i aret E-rraell Aycira 86 Prefbe infomramo L iy Dierersliaed inilad s Aacicns 1| sl

; . ; Download Installars
To automatically import references into your

EndMote library, you zan use the Capture Capture:  Capture Beierenes

Reference button aswell asEndMote Ta imstall the Capture iocl, just drag the Capture Reference button b your Bookmarks bar (also known as “Favorites Bar® or “Bockmaris
—q Toclbar®). In same Browsers, you may need (2 right-cick and select “Add (o Favesles™ or “Boskomark Thiy Link.”

':apture toolbars forlnternet E'>:|:l|.l:l|'l—:‘|' To use It, browse to & page you Bke and click the Capture Reference button in the Bookmar:s bar The Capture Refzrence windaw will

BRI o TH o o R E T4 AR R epen, Follow the [Pstrotions In the window.
(Windows™ orly) or Firefox™ (Windows or

Macintosh™).

Cite While You Write™ Firefox Extension
Use the Endsiots plug-rl to irsert mferences, and format se thae EndMote tsolbar in Firefox to save anline refessnoes
cithtiahs ond EbESGFEpheE Buldmatichlly while you wiitd vour dirdctly id ydar IBrary.
. = " 3 " I Ward. T vl all i ke li
Download the Cite While You Write™ e Acs K Yo SRrary I T Mt EseLr e Wit M i £ e g e
plug-intoinsert references, and format 1.5 Patent 8,063,341
titations and bibliographiesautormatically T T ——
whileyou write your papers in Word. = Cowrosd Wondows wih Intemet Exglorer plug-n = Dowrdod Windows/Macimosh
) # Do Windows MSI of mess program nstalation
Note: If you arz using EndMNote X7 vou do * Duwniosd Nacie

not need to install the plug-in, because
itis already included.



How to perform an online

search in EndNote online

4) Online Search

{7} THOMSON REUTERS

You can search many library catalogs [—
and databases through the EndNote
il'l tf“l'fﬂ e Oniine Search
Step 2 of 3: Connecting to PubMed MEDLINE : PubMed (NLM)

* (Click the Collect tab; then click e i £ (i

Online Search. LR Lo

e 0 e -
+ Select an online database. i
» Perform your search. rsgisakivgor RO
* Mark desired references, and use oo I8

the drop-down menu to add them Gt b Ouie Bearch Rusuia

PubMoc MEDLNE 4 - 90 of 2% reums
to your library. s o) 0 by e
Wy Awtrmncen Wou LD g g "o g1 woew

oW N o

MRS Ml e

o S

:*“_ Vemres b v WIres Dot I8 P ’.“i.m v
o ¢ Add to group...
¢ ma.n o) - Anthropology i
o
- Dwls
g B Unfiled]

New grous



How to manually enter a new
reference in EndNote online

6) Manual Entry T —

ENDNOTE "basic

To enter a reference manually:

* Click the Colledt tab; then click
New Reference.
Select the appropriate reference
1__l__Hlx_4|;_ opriate referen SRRAN
VPE.

* Enter data into the desired fields. o All My References
Fields commonly used by major : Search

Irst, My References

Al My References (440)

Unilied] (16

Trash (0)

¥ Wy Groups
Arthropotogy (150
Nouroscioncs (74)

Owhs (200)

Dukd 3 peolile 10 thawtase
YOur own work

New Reference

Bibliographic
Fields:

Reference Type:
Author:

Title

Year:

Secondary Author:

Secondary Title:
Place Published:
Publisher:

Volume:

Use format Last Name, First name. Enter each name on a new line.




How to import a text file to EnadlNote
online

5) Import Text File Wob o Scnce™  ResoarcherD

ENDNOH: basic

Collect

Toimport references in a plain-text

machine-readable format. Online Search ~ Mew Reference  Import References

* (lick the Collect tab: then click

Import References
Importing from EndNaote?
Filie: Chooss File | pubmid_result.bxd
that matches the database where _
you created the file. import Option: (A sug ) adact Favorkes

= . : T H T ]
* Select the group for imported ol

references, |_import |

* Click Import.




How to capture a reference

3) Capture

Use the Capture Refe
for online resources that do no

bibliographic information presented

)age and creat

such as Google Scholar™ and

PubMed, allow you to capture an

entire page of ref sall at once.

Download Installers

Capture:  Caplure Reference

To install the Capture 1001, just drag the Copture Reference bution to yor
Tooar"), In some bronsers, you may need 10 rght-chck ad select "Add |

To use it, browse to 2 page you bhe and click the Capture Reference butr
open. Follow the Instructions In the window.

Cite While You Write ™

Use the EndNote plug-in 1o insert references, and format
crations and bibliographies stomatically whie you write your
papers In Word, This plug-n 850 ahows you 10 sive coling

Capture New Reference
Sawete & my.encnots.com
Bialiagranhic Fialds | Opticnal Ficlds

Groups:

Bibliographic Fields: At

Reterenns Tyne:

Weltor Ern * Mep

£ THOMSON REUTERS

ErdNots

o

¢ the ficdds must be filed cut.




How to directly send a paper form
PubMedto EndNote Online

& NCBI  Resources ™ HowTo @ Siqn in to NCBI

£ PubMed  + HV —
U5 Mational Library of Medizing

National Insfitutes of Health Create RSS  Create alet  Advanced

Article types Format: Summary = Sort by: Most Recent + Sendto~  Filters: Manage Filters
Clinical Trial
Review
Customize ... Search results File Cliphoard
Collections E-mail
Order WMy Bibliography
© Citation manager

Choose Destination

[tems: 1to 20 of 307655 Selected: 1

Free full
Full text A Novel Entry/Uncoating Assay Reveals the at Least Twe

During Synchronized HIV-1 Infection Generate a file for use with external Giktia Download CSV

Da Silva Santos C, Tarour K, Cimarelii A management software.
PLoS Pathog. 2016 Sep 30;12(9):e 1005887 doi: 10.1371/journal ppat 1005897 Download 1 citation.

PMID: 27690375 Free Atticle N
Similar arices CeateFle] o

Reader comments
Trending articles

Publication dates
hyears

10 years Temporal proteomic analysis of HIV infection reveals remodelling of the host phosphoproteome by
Custom range... . lentiviral Vif variants. hiv testing

Spec Greenwood EJ, Matheson NJ, Wals K, van den Boomen DJ, Antrobus R, Williamson JC, Lehner PJ. hiv treatment
pecies Elife. 2016 Sep 305, pii 18296, doi 10.7554/eLf2. 18296, [Epub ahead of prn] o
Humans , hiv vaccine
o PMID: 27690223 Free Article
Other Animals

Similar articles

hiv intection




How to directly export a paper form
ScienceDirect to EndNote online

Refine filters

Search results: 262,160 results found.

§ ™ Purchase

%! Download PDFs

Year $ | Liver fibrosis in treatrment-naive HIV-ini

2017 (425)
2016 (13,676)
2015 (14,749)
2014 (14,252)
2013 (13,571)

Publication title

The Lancet (9,720)

Vaccine (4,851)

Journal of Hepatology (4 448)
Virology (3,610)
(astroenterology (3,268)

Topic
hiv (42 551)
patient (25 360)
cell (10,224)

on fious Diseaseas, |
G|IlesWandeIer Lioyd Mulenga Michael J
Enos Bernasconi, Patrick Schmid, Carolyr
leDEA-Southern Africa and the Swiss HIV
¥ Abstract | B Research highlights t

HIV viral suppression results in higher
papillomavirus vaccine Original R

Vaccing Volumea 34 [ssys 40
Deborah M. M“n&} Erin M“ses Sandra B
Fiona Smaill, Mark H. Yudin, Marina Klein,
Jason Brophy, Christos Karatzios, Gina O

¥ Ahstract

74 ua}_ﬂ_

¥ Research highlights "f_~

Pill Burden Influences the Association E
Ycunc.— But Not Older HIV-Infected Ac
Jaumal of the Association of Nurses in AIDS ¢
Dawd P. Sheppard, Erma Weher, Kaitlin B
(HNRP) Group

See image results
B Export i |

You have selected 1 citation for export.

Direct export
Save to Mendeley ‘

1 Save to RefWorks ‘

Export file

@ RIS (for EndMote, Reference Manager, ProCite)

BibTeX
Text

Content
Citation Only
Citation and Abstract

<=

| Export |

+ Relevance ¥ |

¥ saesearchaiet | FYRS

Y All access types ¥ |

Help

<=

land Open AcCess

ias Cavassini,
Andri Rauch, for

human

na Loutfy, Sylvie Trottier,
and Lapointe, Lindy Samson,

ioral Research Program

B




How to directly export a paper from
Scopus to EndNote online

TITLE-ABS-KEY ( hiv) i ve W Setakert Set feed

348,81 View secondary documents | View 271770 patent resuls M Analyze search results

DAl

B Export EI Download M Wiew citation overview | 99 View Cited by

o fddto List | More.. -

™ Anal
1 cell-
View

J Golc
2 ass:

Author Name

(L) Soriang, V.

IE
.

[ BT BT =]

[
r

1 Mar e
J De Clercq, E.

ra
oh

(L) Balzarini, J.
() Clotet, B.
) Katlama, C.

T

(=]
il

n
[ I

Subject Area

() Medicine

i
Choose your default reference manager or file type: ﬂ x

Scopus offers integrated export functionality with Mendeley and Refworks.
Or, to use a different reference manager, choose a file format

E Save to Mendeley {+}RIS Format ¢ iz}
EndMote, Reference Manager
RefiVorks direct export O QSU
Excel
) BibTeX
() Text
ASClin HTML
Choose the information to export:
Choose the information you want to export to the reference manager or file.

'Citatinn infarmation only v

ang, J., Lang, J., Zou, X

menez Jimenez, A M., Rodrigo,
M.AM., Milosavljevic, V., (...}, Heger,
£, Adam, V.

Qi, L., Zhang, J., He, T., Huo, ¥,

fhang, £.-0.

ts under Pinto, C.M.A.

Selected fiel includes:

Citation information
Authoriz), document title
source title, volume, izsu
citation count, source an

i

ool controlled Eswaramma, 5., Rao, K.S VK.




How to organize your references Iin
EndNote online

My References Collect Organize Format Match

By default, EndNote places references

into the Unfiled group. You can create
up to5,000 groups to organiz Quick Search [Unfiled]

references in any way that w
! : : All My References : Show 10 per page Md4Pge 1 o3 G
he references you want to group
| - Search
Clic] A . Al Page v adetognun Copy ToQuick List  Delete
* Click on Add to group from the My References e s =k
':”‘:‘[:‘ -down menu and select | My Raferences (448) A ¢ Bedard w::r-:n—--{w Moving solvated electrons with light
< " (Unflied] (28) — simulations of the re sllzatian of ohotoe
Ne'l"/group PR g stions of ¢ xallzation of photo
/ Journal of Chemical Physics
Trash () Empty Added - 20 rtb 21\:( LAY 1/\15

¥ Wy Groups View in Web of Science" My References

* Name the new group and click OK.

Note: You can place a referencein
multiple groups. To see which groupls)

gy (1% wll Full Text Al My References (459)
il heap J fwwse mysndnateweb com Spin-polarized ground s

Physical Review Letters Quick List (1
Emer & New Groep same and chek 'OX sod v 20 Feb 2

' o ! open arezr View In Web of Science’
Folder icon i below the reference. P w full Tt ¥ Wy Groups

ArEhrop ol

a given referenceis currentlyin, click the Trash (50) Empty

Buid 4 gocd e 10 showdate

8 rtrons on M
erng electrons on M




How to delete duplicate references
In EndNote online

Whehancn  Colet JEOTTUCI  femal  Mateh ™ Optios  Conmect™

; . Mooge Wy Omun Oty Ortegs — Pind Dupleates  Mvge Awoy
ItIs possible to have duplicate recordsin

your library. To identifyand delete them,
use the Find Duplicates link uncer the
Organize tab. EndNote compares the W W o

Author, Year, Title, and Reference Type e bl L

Quick Search Find Duplicates

Authort Your L "
Flal e whan idantifving diinliratac My References :
Fielcls when identitying duplicates. g -y M Bk ol st
Wiled) 31 Physcal Review Latters
w20 Feb 2015
a
200 Son-polarized ground state fr Ineractiag ehect
Physical Review Letters
iy TED 2019 Laet Updend 20 1R 2013




How to share references to
other EndNote users

lUse the Manage My Groupslink under the Organize tab.

Click the Manage Sharing button next to the group

you'd like to share,

Enter the email addresses of the people with whom

you'd like to share.

Note: Any individual you share your group with must

have an EndNote account in order to view references.

Enter the email address they use to access EndNote,

Choose whether to give your colleagues Read-only

access, or Read & Write access. Click Apply.

* Read-only access allows designated users to view
references, use them in Word documents, or copy
them to their own library.

* Read & Write access allows the designated user to
add, change, or remaove references in the group, as well
as anything Read-only access allows.

Marage My Greups Oty

Manage My Groups

HNumber of
References
Anthropology 152

MNeuroscience 75
Owis 1596
Physics 16

by Groupst

Herama
Aoy
Heama

Hiw it

Add E-mail Addresses io Physics’

Eriber el addnesses, Lise the Enter or Beturn key 10 Separate
addresses

win doefenanaie mm
e foe ool oo
e | 2Earcinote oo

a m a
Select & text Nie with e-mail addresses separated by commas,

Chadia e &0 g Seislis]

# Read only  Read & Write




How to find the best fit journals for
your manuscript

EndNote™  MyReferences  Collect  Organize Format  Match  Options  Downloads

Find the Best Fit Journals for your Manuscriptﬂwered By Web of Science'

Enter your Manuscript Details: 1= Click

Mateh ta
_— g 2= Wirite y@w mammg@n’ﬂpﬁ &

G 3= Wrrite your manuscript abstract

*Abstract:

*required

4= click Find journals

References:

Select Group

Find Journals >




How to synchornize your references
between Endnote online and EndNote
Desktop

1) Syncing with the Desktop

J EradNote X7 - [Teanetenl]
\ it References Groups Lools

naated v

--:LM]‘ and online 1

H'I A"
computers. (Hint: [1

‘_7,“\'[’|:: on \H’[}-‘[ ( H[I[]u“

wumu swill be displayed in EndNote online. Onces
zed library will l:re

ze[lew t»—v: in ﬁ” synchronized w]w->~‘?~TI e library

1tion, but

will l e availab
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»

4 Trzh
= - current rasearch
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% NU T weter's block
R ey
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@ for gencaf

Author
Bergler,
Bergher E

L0, Yigang; Fan..

Divijaink, ¥, M.
Dunn, B, Smie,
b Anthony

Hu, X.¥.; Wang, ..

Hudepohl Dasa

" Huston. P,

only custom w)utehe
-~ ) svnced & - ReseaecherdD
‘ O‘,‘u Publcstions

& Pubication Lst

4

Iohnson 5. H.

Jones, John Fhilp

Wbl 0y ¥akese

wlerence |

W08
7006
01
1548
1982
1999

e

Dows “writer's bilock” exat?
Uncomveiows mechaniens in wriler's block
20 shi Ji Zhongquo e ;" chuan tong di yan xu yw van jin” quo i xue §

suplay a type L ¢ chieeadin

DICCK manusinpt reference sty e
Aqoqo. a celebration of creativity : stores paems shits artworks reyl
FI"II 'N"\Cl l"xlgllﬂ" Cresnane e Il’l‘l'llllg \‘Ill’, ll' 'R""’ \tramp
287 secrets of reénventiog yeur Be : big and smadl ways 1o embrace
Resohving writer's block
Toventy frvw ways to aveid writer's block

The advertiing buiness : operations, creativity, meda planning inte

) Pubication Lat 2

Find Ful Text Rating

Bolurence o Jownal Ast




RIS (Research Information Systems)

RIS (Research Information Systems)is a
standardized tag format developed,to
enable citation programs to exchange
data.

It Is supported by a number of reference
managers.

Many digital libraries, like IEEE Xplore,
Scopus, the ACM Portal, ScienceDirect,
and SpringerLink, can export citations In
this format.
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How to load Endnote tools In

Word office

This Article is intended to restore the EndNote CWYW tools. If you've never seen the EndNote tools loaded in
Word, please see the Article with installation steps for your version of EndNote and Word.

Word 2007/2010/2013/2016:

1. Word 2007: Click on the Office icon and select "Word Options.”

Word 2010/2013/2016: Click on the File ribbon and select "Options."
2. Click on "Add-ins."

3. Change the "Manage" options to "Disabled ltems."
4. Click Go.

9. Highlight any EndNote item(s) and click "Enable."
6. Click OK.

Word 2000/2002/2003:

1. Click the "Help menu" and select "About Microsoft Office Word."
2. Click "Disabled ltems."

3. Highlight any EndNote item(s) and click "Enable.”
4. Click Close.

5. Click OK.

If prompted, select to allow the file(s) to be loaded by Word. Close and re-open Word when this is done.



o ____________- WA VW WA VAU W
Note: With Word 2010/2013/2016, the Ribbon tab may also be unchecked. Click on the File menu and select

Options. Click on Customize Ribbon and Check EndNote if it is unchecked. Click OK to display the EncNote
tab in the Word Ribbon.

If the option to "Disable all Application Add-ins" is checked in Word 2007/2010/2013/2016, that can also cause
the tools to not appear. To turn off this setting, do the following:

1. Word 2007: Click on the Office icon and select "Word Options.'
Word 2010/2013/2016: Click on the File ribbon and select "Options.”
2. Click on "Trust Center."
3. Click "Trust Center Settings.”
4. Click "Adc-ins."
5. Uncheck "Disable all Application Add-ins (may impair functionality)' and click OK.
. Click OK.
7. Exit Word and then re-open it

If you still do not see the tools or you are getting an error message, make sure you have updated EndNote with
the latest updates. The directions for installing the updates can be found here.



